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Introduction

Thank you for choosing JDSU’s Validator  tool with Plan-Um software. This booklet refers to the 
individual components as:

Validator or Validator-NT − the hand-held tool that tests and certifies cable, and 
downloads test results to the Plan-Um software.

Plan-Um − the software application that enables you to draw room layouts, a network 
topology, plan your cable installation, and create a cable test schedule. 

System Requirements

Plan-Um is an independent stand-alone software program and does not require interoperability with 
any other software.  The following are requirements to successfully run Plan-Um on your computer:

Minimum screen resolution:	 800x600 dpi
Operating system:			   Windows 2000, Windows XP, Windows Vista
					     Mac OS X 10.4 (Tiger)
					     Linux (tested on Debian 4, Red Hat 9, Ubuntu 7.04)
					     Suse 9.3, Fedora Core 6, and Gentoo
Available Disk Space:		  15 Mbytes 
Memory:				    256 Mbytes minimum
Printing:		  Fully supports printing to PDF files, Adobe Acrobat 6.0 or higher

Data Entry Requirements 

Field Limitations			   20 characters maximum 		
Character Limitations		  None
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Installing Plan-Um

Install Plan-Um from the CD onto your PC. Plan-Um does not run directly from the CD. 

1.	 Close all Windows programs, including all virus-detection and screen saver software.

2.	 Insert the Plan-Um CD into your CD drive.  The PC automatically starts the installation.

3.	 Select a language to use for the software installation and Plan-Um.

4.	 Follow the installation instructions and accept the License Agreement to complete the installation.  

5.	 The installation automatically creates a desktop shortcut to Plan-Um.

6.	 Plan-Um and Validator documentation can be downloaded from www.jdsu.com/validator.

The files are in Portable Document Format (PDF).  To view, store, or print the instructions, you 
must have Adobe ReaderTM installed on your pc.  Adobe ReaderTM is available free from Adobe’s 
web site.

Note:  When downloading Plan-Um® updates from our web site, http://www.jdsu.com/validator, 
please follow the update instructions carefully.  JDSU recommends that you un-install the current 
version of Plan-Um before re-installing the new software release.  With Plan-Um 2.3.0, you must 
also download the associated Validator Firmware Update (Val_App 2.3.0) in order for the job files to 
work properly.  
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Starting Plan-Um

1.	 Double click on the Plan-Um icon.   

2.	 The program opens to the Plan-Um dialog box with eight tabs.

Job Information contains Tester Information and Site Information. Tester Information identifies 
contact information for the company performing the job. Site information contains information 
about the site you are designing. Tester and Site Information data prints on all job reports.

Network View allows you to create a network topology independent of the cables created in the 
floor plan view.

Network Devices summarizes the devices from the network view tab. This table is populated as 
the devices are added and can be printed.

	 Floor Plan allows you to design a home/office floor plan layout with ports and cable runs. 

Cable Test Schedule summarizes the cabling job and creates a test schedule of all cable runs. 
This information is populated automatically as you design the cable installation in the floor plan.

Detailed Test Results displays individual cable test results after tests are performed using the 
Validator.  These results include Pass/Fail, speed, wiremap, length, SKEW, SNR, and BERT.

Cable Types allows you to create a custom cable or modify and rename an existing cable 
definition.

Job Notes can be used to record pertinent job information that may be helpful to the installer in 
the future.

Network Devices

Network View

Cable Types

Floor Plan

Job Information

Job NotesDetailed Test Results

Cable Test Schedule
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Menu Bar
A menu bar (File, Edit, View, Image, Help) appears at the top of the panel.

File	 Click to display New, Open, Save, Save As Job, Import and Export CTS File, Export Tut 
File, Page Setup, Print Preview, Print, Print Labels, and Exit.

Edit	 Click to display Cut, Copy, Paste, Delete, and Settings, Undo, Redo.

View	 Click to display Job Info, Network view, Network Devices, Floor Plan, Cable Test Schedule, 
Detailed Test Results, Cable Types, and Job Notes. Also included are options to Zoom, 
Show Room Name, Show Room Dimensions, Show Points and Use Metric Units.                  

Image	Click to display Center and Background.

Help	 Click to display Contents, the Welcome Screen, or About.  
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Icon Toolbar

Use the icon toolbar as a shortcut to create a new file, open an existing file, save a file to your hard 
drive, save a file to some other media, and to cut, copy, and paste a floor plan. The last five icons 
allow you to magnify (Zoom) or shrink the floor plan view, move the floor plan on the desktop drawing 
canvas (Center), import a background, and open help window.

Import BackgroundNew

Open

Save

CutPrint Contents

Print Label Copy

Paste Center

Zoom



�

Plan-Um Settings

To change Plan-Um settings go to the edit menu and choose settings.  This will bring up the settings 
dialog.  There are five tabs to choose:

General

This tab allows you to change the number of recently opened job file names that appear in the file 
menu.

Language

This tab allows you to choose the current language for Plan-Um.

Report

This tab allows you to change the pages that print when you select the print button. The current tab 
option prints the data displayed on the currently selected tab (i.e., what you see). The print all option 
will print the entire job report. The print selected option allows the user to print data on selected tabs 
on a tab-by-tab basis.
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Font

This tab allows you to edit the application font for Plan-Um and the font which appears in the Floor 
Plan and Network View tabs.  Note:  not all application fonts look good and are readable.

Icon

This tab allows you to edit the sizes of the Icon scale in the Floor Plan and Network View.
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Page Setup and Scale

Plan-Um opens with a default page size, orientation, and scale appropriate to most drawings.  
However, the Page Setup dialog box allows you to select alternate Print Setup, Page Size, and 
Drawing Scale options to accommodate various layout sizes for the Floor Plan and Network View 
menu tabs.  For all other menu tabs, the Page Setup allows you to select the paper size and print 
zoom options only.  

The default print setup for the floor plan is 8.5” x 11” paper, landscape mode, with a drawing scale 
of 1” equals 20’.  To adjust the floor plan Drawing Scale, Page Size, and Print Setup, click the Page 
Setup dialog from the File Menu and select alternate attributes on each menu tab.   

You can also save these settings to a JDSU Template (TUT) file so that new job files that require the 
same settings can be easily reproduced.  (See Managing Job Files, Save and Export As Template).

Print Setup

To select a paper size other than 8.5” x 11”, click the down arrow and select the paper size you wish 
to print your drawing on from the list.  To change the page orientation from landscape to portrait, click 
the alternate selection.  To change the Print Zoom from 100%, click the down arrow and select the 
desired zoom from 25% to 400%, from the drop down menu.  
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Page Size

Typically the drawing page, represented by the white area on your screen, and the image printed on 
your paper are the same.  However, to select a page size for your floor plan that is different than your 
printer paper, click Predefined Size and using the drop down menu select Standard, Metric (ISO), 
ANSI Engineering, or ANSI Architectural to adjust the scale for your drawing.  Click the down arrow to 
select Letter, Folio, Legal, or Tabloid paper.

Or, click the Custom Size button and define a page size by entering the dimensions of your choice 
and selecting unit increments of inches, millimeters, centimeters, pixels, or feet.  In addition, you can 
change the page orientation from landscape to portrait.

Drawing Scale

To adjust the drawing scale, select either the Pre-defined Scale or Custom Scale to input a drawing 
scale of your choice. The Pre-defined scale allows you to select from a list of 6 choices ranging from 
1” = 5’ to 1” = 50’ using English units, or 3 choices using metric measurement units.  The drawing 
scale allows you to adjust the scale on the ruler to the size of the building you are cabling and then 
add the rooms and cables so that the drawing is appropriately proportioned to the building on the 
paper you print your job on.  Changing these settings modifies the Page Size measurement units.

To display or hide the room dimensions on your drawing, click the View drop down dialog box and 
select Show Room Dimensions to alternately show or hide the room dimensions using the scale you 
have selected.  
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Print Preview

To see what will be printed you can open the print preview. Specify the pages you would like to print 
using the report tab in the settings dialog and the appearances and paper sizes using the page setup 
dialog. Print preview serves as a snapshot of what would result by hitting print. At the top of the print 
preview there are buttons to do a quick print (bypass the print dialog), normal print (shows print dialog 
first), page setup, and the navigation tools. To navigate one page at a time click the left and right 
arrows. The arrows with the line go to the first and last pages of the print results. To jump to a specific 
page edit the number in the line edit and press enter.
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Import and Export CTS File

Plan-Um provides the capability to export cable test schedule data to files and import cable test 
schedule data from files.   Plan-Um can import and export data in three types of file formats – tab 
delimited format, comma separated format, and Microsoft Office Excel Workbook format.  The 
following procedures are used to import or export cable test schedule data from Plan-Um:

1.	 Select the ‘Import and Export CTS File…’ option from the File menu.  The ‘Import and Export 
Wizard’ dialog appears.

2.	 Select the option to either import cable test schedule data or export cable test schedule data to 
a file and select Next.

3.	 Select the file type to import or export and select Next.
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4.	 By default, all cable test schedule fields are imported or exported.  To change the default, 
select the ‘Select Fields’ button and select those items desired for import or export.  The ‘Cable 
ID’ item is always selected for either import or export.

5.	 Enter a filename into the text field or browse to select a filename.
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6.	 Select Finish to import or export the cable test schedule data to the file.
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Defining Job Information 

Click the Job Information tab to display the Tester Information and Site Information entry fields.  Job 
information prints on the Cable Test Schedule and Detailed Test Results.

Tester Information

In the upper portion of the Job Information dialog, fill in your Company’s contact information. 

1.	 Type the Company Name, the name of the Installer, the Phone Number, and the Email address.

2.	 Fill in the Address fields on the right side of the screen.  

3.	 If you are including your company’s logo on the printed Cable Test Schedule or Detailed Test 
Results, use the Browse button to locate your company’s logo in an image file. Once found, click 
on the image to fill the Company Logo field with the path to that file location.  Plan-Um supports 
the following image file formats:  .PNG, .BMP, .JPEG, .PNM, .MNG, .XBM, and .XPM.  The 
maximum pixel dimensions of the logo you insert should not exceed a width of 200 pixels and a 
height of 60 pixels.  The Use Pics box is a default setting that can be unchecked if printing images 
causes problems with your printer.

Site Information

The bottom portion of the Job Information window contains Site Information. Fill in the information 
about the site you are designing.

1.	 Type a JOB ID # or name to identify the job on which you are working. The Job ID # appears at 
the bottom of each screen in the left corner.  It also appears on printed documentation associated 
with the job.

2.	 Complete the Customer Contact Information: Company Name, Contact, Phone Number, and 
Email address.

3.	 Fill in the Address fields on the right side of the screen.
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Creating a Network View

The Network View feature in Plan-Um allows you to quickly and easily create a topological 
representation of your physical network, annotate each piece of equipment, and generally 
characterize the connection method.  It is a simple tool that documents and illustrates network 
connections independent of the cable run information you may create in the Floor Plan section of 
Plan-Um.  

Network View provides a quick way to see the architecture of your network and document moves, 
adds, and changes in an organized and effective manner. You can designate a name and add notes 
to each network device.  In addition, the free text features and angled connection features allow 
you to create a professional looking network diagram for presentation to your customer.  It is easy 
to customize and update equipment notes to record the legacy information so necessary for good 
network management. 

Placing Network Icons

Network icons include computers, telephones, routers, hubs, the internet, printers, access points, 
bridges, firewalls, servers, and faxes.  Use these icons to identify network devices in the layout.

1.	 When you click an icon on the left tool menu, it pops into the upper left corner of the canvas.  
Multiple clicks will create multiple icons numbered in the order of your clicks.  
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2.	 Click on the Network icon on the canvas again and drag it to the position where you want to 
place it.

3.	 Repeat this process with the same or other icons until all Network icons are placed on your 
layout.
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Customizing the Name of the Network Device Icon 

You can customize the icon name that displays on the canvas and add notes using different methods.  

1.	 Click on the New Device dialog box at the top of the left toolbar.  Type the Name you wish to 
specify and then click the icon you wish to add.  The custom name will appear on the canvas 
under the icon.  Text entered in the New Device dialog box will automatically be associated 
with every icon placed on the canvas until you highlight and delete the text from the dialog box.

2.	 Double click the icon once it is placed on the canvas.  A popup dialog box appears titled 
“Properties”.  Type the new name information and any notes you want to add.   Click OK to 
display the new name.

3.	 You may also right click the icon once it is placed on the canvas, and select Properties.  A 
popup dialog box appears titled “Properties”.  Type the new name information and any notes 
you wish to add.  Click OK to display the new name. 
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Placing Free Text on the Network View Layout

You can also place text with information regarding the network anywhere on the Network View 
canvas.  For example, you can title your Network View drawing, insert general information about the 
network, or identify specific user groups, floors, etc.

1.	 Click Add Text on the network toolbox in the Graphic Tools page.  

2.	 Double click Text once it is placed on the canvas.  When the Properties dialog box pops up, 
enter the text, select the font size, and click OK to place the text on the canvas.  Click and hold 
the left mouse button to move the text anywhere on the screen.

3.	 To delete text, click on the text on the Network View canvas and press Delete or right click on 
the text and choose delete text in the context menu.
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Adding Lines

Once the Network Port icons have been added, draw the lines between each piece of equipment to 
simulate the physical layout of your network.

1.	 Click the Lines button at the bottom of the left toolbar menu and select one of three line 
types.  You may differentiate between the types of connections by clicking the down arrow 
and selecting a dash line, a solid line, or a dash/dot line to denote a connection type of your 
choice.

2.	 Click Add Line.  When you move the mouse to the floor plan, the cursor changes from a 
cross to an arrow.

3.	 Position the cursor over a network icon, hold the left mouse button down, and drag the cursor 
to the network icon you want to connect to.  This creates a line between the two icons.  
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Angling Lines

You may also create angled lines that bend to allow you to change the direction of the path in any 
direction.  Adding multiple inflection points on a line path allows you to go around devices displayed in 
the Network View.  

1.	 Double click on a line at a point where you would like to bend the line to create an inflection 
point or right click and select add point.  You can drag the point to any desired location. Note 
that the point may disappear if the “Show Points” option is not checked on the View menu.

2.	 You can add as many inflection points as you want to create complex paths.

3.	 To delete an a line segment left click on the segment and press delete or right click on the 
segment and choose delete line.  
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Adding Network Sheets to the Topological View

Depending upon the complexity of the network layout you create, you may require additional Network 
View sheets to depict other portions of the network or other floors.  For example, you could create 
separate topologies for phone, computing, security, or by department, campus location, or floor.  
Select the Network Sheet you wish to print with your job.  

1.	 On the bottom left toolbar, click Network Sheets.  Three menu tabs appear, Add Sheet, 
Remove Sheet, or Refresh Layout.  Select the desired sheet option.  

Printing the Network Topology

The Network View can be printed to illustrate the Network Topology.  Attach the network sheets to 
your End of Job Report, including the floor plan and test results, present it to your customer with your 
invoice, and keep a copy for your records.  Unless otherwise specified, Network Sheets will print on 
8.5” x 11” paper in landscape mode.

1.	 Select Print from the File pull down menu.

2.	 Or, use the print icon on the main toolbar.  
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Using Device Notes

The device notes tab contains a read-only table for viewing devices along with their type, sheet, and 
corresponding notes. This table is populated as the devices are added to the Network View and can 
be printed.
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Defining the Floor Plan

The Floor Plan tab allows you to draw a simple floor plan to scale and place the ports and cables to 
be installed.   Drawing a room layout adds to the documentation of the job, making it very clear what 
cables and ports are being installed, and where they will be placed. The ports and cables placed on 
the floor plan are used to automatically create a Cable Test Schedule. 

As an alternative to drawing the room layout using the Plan-Um tools, a background image can be 
imported from a CAD or other drawing software tool. See the section in this document titled Adding a 
Background Image for the details of that approach.  In either case, placing ports and cables over the 
room layout or background image is the easiest way to create a Cable Test Schedule manually.  

Note that by using the Cable Test Schedule tab you can enter a cable list directly, without creating 
the Floor Plan if you prefer. See the section in this document titled Creating a Cable Test Schedule 
Manually. 

The following steps detail the process of creating the optional room layout for the Floor Plan:

Adding Rooms

1.	 Click the Floor Plan tab.  A toolbar menu appears in the left panel with several labeled buttons. 
Use the vertical scroll bar to the right of the buttons to view all buttons, including those that 
do not display in the initial view.  The list of buttons includes Residential Rooms, Commercial 
Rooms, Specific Use Ports, General Use Ports, Cables, Floor Tools, and Cable Manager.�
 
The list of Residential Rooms includes a living room, family room, home office, kitchen, 
bathrooms, bedrooms, and closets.  Additional icons are available to create a garage, wire 
closet, foyer, etc.  The list of Commercial rooms includes a lab, cubicles, offices, a conference 
room, bathrooms, warehouse, hallways, and wiring closets.  Plan-Um gives you the 
opportunity to change the name of any room by placing the cursor on the room, then clicking 
the right mouse button to display a pop-up menu that lists 3 options: Copy room, Rename 
Room, or Delete Room.

•	 Copy Room makes a copy of the room. Click on the room and place it anywhere on the 
floor plan.

•	 When you click Rename Room, a dialog box appears which allows you to type a unique 
name for the room, and then click the OK key.  Plan-Um replaces the name of the room 
with the new name.

•	 Delete Room removes the room from the floor plan.
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2.	 Begin by selecting either a Residential or Commercial floor plan. Whichever you choose, a 
list of rooms appears in the left column. Use the vertical scroll bar to see the entire list.

3.	 Plan-Um opens with a default drawing scale of 1” equals 20’ and a print zoom of 100%.  The 
upper left hand corner of the drawing canvas is viewable on your screen.   To view the page 
as it would print, select the Page print zoom from the zoom drop down menu on the toolbar.  
See the Page Setup and Scale section of this manual for details on how to manipulate these 
options.

 

4.	 When you click a room name, the room displays in the upper left hand corner of the drawing 
canvas. Each room defaults to a pre-defined size and appears on the canvas based on the 
drawing scale you select. Resize the rooms by placing the cursor over a horizontal or vertical 
wall line. When the cursor changes to a double arrow, drag the wall to expand or contract the 
size of the room. The room name can also be dragged around inside the room to the desired 
location.

Note:  The Page Setup and Scale settings are automatically saved for each tab in the job file so that 
when you re-open the job or create a new job, the selected Page Setup options remain. 
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5.	 Continue to add rooms, dragging and placing them anywhere on the floor plan area according 
to the actual layout of the office or home.  

Adding Custom Rooms

1.	 To add custom rooms, click inside the blank box labeled Custom Room Name at the bottom 
of the rooms list.  Type the name of the room, such as a Gym or Loft. The name of the room 
is limited to 20 characters. Then click the Add Custom Room button. Place and size it as 
described above.

2.	 If you add more than one room with a custom label, Plan-Um will automatically increment the 
room number by clicking the Auto Increment check box. 
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Adding Free Text

1.	 To add free text to the Floor Plan go to the Floor Tools page of the toolbox and click the Add 
Text button. The text behaves the same as the text from the Network View Tab.
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Copying and Pasting Rooms

When there are multiple rooms of the same size to place on a floor, such as cubicles, you can copy 
one or more and paste them in specific locations. This eliminates the need to place and size each 
cubicle separately. 

To copy the same type of room or sub-room, click on the room you want to copy on the floor plan, 
and then click the Copy icon on the menu bar. You can perform the same function by selecting the 
Copy option on the Edit menu or right clicking on the room and selecting Copy Room from the pop-up 
menu.�

1.	 To complete the Copy Room function after selecting the room you want to copy, click the Paste 
icon. The new room appears on the floor plan. Click on it and move it to the location you want. 
The Paste option on the Edit menu performs the same function.
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Adding a Background Image 

Although Plan-Um software operates completely independently, you can also export a CAD or other 
drawing software floor plan to a .png, .bmp, or .jpg file, and import the image for your design layout.  
Use this design layout instead of creating rooms to define your job.  All other advanced features and 
functions of Plan-Um work in the same manner with this image.

Follow these instructions to import a background image:

1.	 Click on the Background Image icon on the toolbar.  

2.	 Use the Browse button to locate the image file you wish to insert.  Once found, click on the file 
name to populate the Background Image field with the path to that file location. 

3.	 Press OK and the image file you selected appears as a background image on your screen.  If 
images are moved to another directory, re-linking the image will be required.
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Defining the Port Layout

After you design the room layout, you must now identify the ports in each room that the cabling 
supports.  This process is the key to generating a Cable Test Schedule that can be uploaded to the 
Validator. Before adding cables to the Floor Plan, you must first add Ports that are the termination 
points for cables. The ports represent wall plates or other cable termination hardware. The ports 
can be added to a room layout, placed on top of a background image, or simply placed on an empty 
canvas. Once the ports are placed on the canvas, cables can be connected between them.

On the left tool menu, there are two buttons, Specific Use Ports and General Use Ports. The 
difference between the specific and general use ports is both the appearance of the icons, and the 
Use attribute that is shown on the Cable Test Schedule. 

Placing Specific Use Ports

Specific use ports include fire and security alarms, cable televisions, telephones, speakers, satellite 
dishes, computers, and other equipment.  An icon appears next to each. There is also an Add Custom 
Port box that works like the Custom Room box described above.

1.	 When you click an icon, it pops into the upper left corner of the floor plan.
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2.	 Click on the port icon on the canvas again and drag it to the position where you want to place 
it.

3.	 Repeat this process with the same or other icons until all specific use ports are placed 
appropriately.
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Placing General Use Ports

General use ports are wall plates with one to six jacks, patch panels, or a communications center.  An 
icon represents each port.

1.	 When you click on a port, it pops into the upper left corner of the floor plan.

2.	 Click on the port icon on the canvas again and drag it to the location where you want to place 
it.

3.	 Repeat this process with the same or other icons until all specific use ports are placed.              
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Adding Cables

Once ports have been added to the floor plan, the next step is to connect cables between the ports.  
In addition to adding cables one at a time, the Cable Manager tool allows you to connect multiple 
cables between one port, referred to as the End Point (To port) and any number of other ports.   

To Add One Cable

1.	 Click the Cables button on the left tool menu. This displays the Cable Types to Display and 
the Cable Type to Add fields.

2.	 When you click the down arrow on the Cable Type to Add field, a list of Cable Types displays. 
The available Cable Types are CAT5, CAT5E, CAT6, CAT3_4P, CAT3, CAT3_2P, RG-6, 
RG-59, RG-58, Fire, Security, Audio, Tel_Cord, CAT5STP, CAT5ESTP, and CAT6STP. If the 
type needed is not on the drop down list, you can define a custom cable type. This feature is 
discussed in the Advanced Features section of this document, Adding Custom Cables. 
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3.	 Click Cable Type To Add and select a cable type from the drop down list and click the Add 
Cable button.  When you move the mouse cursor to the floor plan and place it over a general 
or specific port, the mouse cursor changes to a vertical, upwards pointed arrow.

4.	 Position the cursor over the port icon which will be one end of the cable, press the left mouse 
button down, and drag the cursor to the port icon which will be the other end of the cable.  This 
creates a color-coded cable “run” (a line between the two ports). 
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5.	 There are three basic Cable Types supported by the Validator, Data, Phone, and 2-Wire. Each 
cable type is assigned a specific color: Data cables are solid gray lines, Phone cables are 
blue-dashed lines, and 2-Wire cables are green-dotted lines.

6.	 Each time you add a cable run, a line is displayed on the floor plan. If the floor plan becomes 
cluttered or difficult to view, click the down arrow on the Cable Type to Display field and select 
the cable types which you want to view at the time.  
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7.	 If you click the left mouse button on empty space while adding cables a point will be created to 
create a bend in the cable. You can add as many points as needed or hit escape or right click 
in empty space to cancel creating that cable. Clicking on another port finishes creating that 
cable run.

8.	 You can also double click on an existing line at a point where you would like to bend the line 
to create an inflection point or right click and select add point.  You can drag the point to any 
desired location. Note that the point may disappear if the “Show Points” option is not checked 
on the View menu.
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Adding Bundled Cables

When you need multiple cables grouped together you want to use a Bundled Cable. Bundled Cables 
are added the same way as regular cables and look like one cable on the Floor Plan but show up as 
multiple cables in the Cable Test Schedule.

To Add Cables Using the Cable Manager

1.	 Click the Cable Manager button on the left tool menu. This displays the End Point, Cable 
Type, Port ID Checkbox, Short by and the Auto-Check fields.

2.	 Using the End Point drop down menu on the left toolbar, select the End Point you wish to 
connect your cables to.  This port will be the “To” port on the Cable Test Schedule.  
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3.	 Use the drop down menu to select the Cable Type you wish to add.  The Sort By drop down 
dialog box allows you to sort the table alphabetically or by the number of connections.

4.	 Select the Port ID check boxes from the list that you wish to connect to the End Point.  

5.	 Click Add Cables to add cable connections from the selected ports to the selected End 
Point using the Cable Type you selected.  The number of connections for each Port ID are 
automatically updated in the table.
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6.	 The Auto-Check drop down menu allows you to automatically check all Cable IDs of a 
particular Cable Type and click check to select or uncheck to deselect these Cable IDs.

For example, to check all of the phone ports in the connection table, select Auto-Check Phone, 
and click on Check.  To uncheck all of the phone ports, select Uncheck.  Click Add Cables to 
complete the operation.
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To Remove Multiple Cables Using the Cable Manager

1.	 Use the drop down dialog box to select the End Point you connected cables to.  For port 
reference, click on the Cable Test Schedule tab and look at the To port ID.

2.	 Select the Cable Type you wish to remove from the Cable Type drop down menu.

3.	 Select the port ID check boxes you want to remove.  Note that even though all port ID boxes 
can be checked, the only cables that will be removed are the ones that actually have a 
connection to the selected End Point.  

4.	 Click Remove Cables to remove all of the cables of the selected cable type. The number of 
connections for each Port ID are updated in the table.  
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Advanced Features

In addition to the basic functions for designing room layouts and placing ports and cables,
Plan-Um provides advanced features in the Floor Plan Tab to allow you to design a multiple-floor 
home or commercial building and connect cables between floors. There are also Floor Plan tools to 
allow the importing of image files created in other CAD or drawing programs, shrink or expand the 
floor plan view (using Zoom) and move the objects on the floor plan around on the canvas (using 
Center.)

There is also another Tab, the Cable Types Tab with a set of tools to allow you to add custom cables. 

Adding, Removing, and Copying Floors

Follow these instructions for adding a floor.

1.	 Click the Floor Tools button to display the Vertical Run feature, and options for adding, 
removing and copying a floor. The Choose Floor field initially displays Floor_1.
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2.	 To add a floor, click the Add Floor button. The floor number in the Choose Floor field changes 
from Floor_1 to Floor_2 and displays a blank floor plan on the desktop. Click   the down arrow 
under Choose Floor, Floor_1 and Floor_2 appear as selections.  To select the floor plan you 
want to work on, click the appropriate floor.  The selected floor plan appears on the screen.

3.	 If you defined multiple floor plans and want to delete one, click the down arrow on the Choose 
Floor field, select the floor you want to remove and click the Remove Floor button.
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4.	 You can also add a floor that is identical to an existing floor by displaying the floor layout you 
want to copy in the Choose Floor field.  When you click the Copy Floor button, the Floor 
number automatically increments and appears in the Choose Floor drop down box.  The same 
floor plan, port layout and cable runs appear on the copied floor. 

5.	 If any of the ports or rooms differs from the original floor plan, you can delete and add by using 
the instructions above, thereby creating a unique layout.
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Adding Custom Cables

The Validator is designed to verify that cables meet specifications defined in a very flexible fashion. 
The specifications set for a cable type define the tests that must be passed by a cable of that type for 
it to be given a “Pass” result. Any test which a cable fails causes that cable to be given a “Fail” result. 
Many standard cable types are pre-defined in the default list provided with the Validator. In addition 
to the default types, you can define new types by creating new or modifying existing cable type 
definitions. To define a new cable type, open the Cable Types tab. This displays the Cable Types 
window shown below.

The screen shows four tabs: Data Jack, Phone Jack, 2-Wire, and Jack Bundled Cables. The first 
three tabs define the basic cable categories that the Validator supports, and correspond to the three 
test jacks on the Validator and its remote unit. The bundled cable tab is used to define a grouping of 
multiple cables that the Validator supports, and may correspond with either the three test jacks on 
the Validator and its remote unit. Choose the cable category tab for which you are creating a custom 
cable type. 
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Data Jack Tab

The Data Jack tab controls the detailed specifications for 8 wire, 4 pair cables that are normally 
terminated with RJXX connectors and used for Ethernet.  Inserting them into the 8-pin connector on 
the Validator tests cables in this category.  The mapping in this connector is standard Ethernet pairing 
1-2, 3-6, 4-5, 7-8.  

1.	 To start creating a new cable type in this category, choose a type from the drop down list in the 
Load Data Type field. If you select New, you must enter data manually in all other fields. If you 
choose an existing type, the pre-defined specifications for that type populate the fields on the 
rest of the form.

2.	 Modify the specifications and save a new cable type by typing a unique name in the Type 
Name field. The default types included with Plan-Um cannot be modified and stored under the 
original type name, but can be stored with a new name.
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Test Parameters

Date Jack Cables are primarily for testing Ethernet cables, the Speed specification determines what 
data rate the Validator will use to test for proper operation. Validator supports SNR and BERT testing 
at either 100Mb or 1000Mb. If you want to define an      8-wire type which is not for Ethernet use and 
does not need to have a speed verified, the speed can be set to None, and no BERT test will be run.

The Max Skew (ns) is the maximum difference in delay allowed between pairs in nanoseconds. This 
specification only applies to 1000Mb Ethernet, and is only applicable to a cable that can support 
that data rate. 40nS is the absolute maximum allowed due to the symbol rate at 1000Mb. This 
specification can be set to 0 to allow cables to pass the testing without requiring this parameter to be 
met.

Min SNR is the minimum signal-to-noise ratio allowed. Generally, 20db is the minimum acceptable 
level in 100 Mb and 1000Mb mode. It can be set higher to require the testing to show a higher 
margin in the noise level. This specification can be set to 0 to allow cables to pass the testing without 
requiring this parameter to be met.

The Length field allows you to specify whether the Maximum Length field will be checked during 
testing. If this field is set to “Yes”, the measured cable length will be compared to the Maximum 
Length specification, and the Pass/Fail result will be stored. If this field is set to “Don’t Care”, the 
length will be measured and recorded, but the Maximum Length is not checked. Note that the pF/ft 
(length constant) must be set to match the characteristics of the cable for the length measurement to 
be accurate.

The pF/ft. field specifies the length constant used for capacitive length measurements in Pico farads 
per unit length. This measure can display as meters if you selected Metric on the View menu. Length 
of cable is rounded to feet or .5 meters.

The Connector field is simply a comment field for the operator.

Wire Mapping

The section labeled Wire Mapping defines the connection between the pin assignment of the wires in 
the connections between one end of the cable and the other. If the In Use box is checked, the pair will 
be tested. If it is not checked, that pair is not tested. By default, all boxes are checked.

The Map To field defines the pair at the remote end to which the main unit pair is connected. Each 
pair can be used only once. 

Pair Polarity indicates whether or not the connection is Normal, Reverse, or Don’t Care.  For example:

	 1-2 Map To:  1-2 Normal means 1 goes to 1 and 2 goes to 2
	 1-2 Map To:  1-2 Reverse means 1 goes to 2 and 2 goes to 1
	 1-2 Map To:  1-2 Don’t Care means either normal or reverse is acceptable
	

The Split Test field determines that the cable wire pairing is verified and must be correct for the cable 
to “Pass”. Don’t care means that pairing is unimportant.

Shield defines Shield continuity will be tested and required for the cable to “Pass”. If Yes is selected 
in the Shield box, shield continuity will be tested.  If No is selected, the shield continuity is not a Pass/
Fail criteria.
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Phone Jack Tab

The Phone Jack tab controls the detailed specifications for 6 wire, 3 pair cables that are normally 
terminated per USOC 3-pair definition, and used for telephone connections. Cables in this category 
are tested by inserting them into the 6-pin connector on the Validator.  As described above, a new 
type can be defined by selecting an existing type from the drop down list to modify, or New, to define 
a new type from scratch. As with Data Types, the default types included with Plan-Um cannot be 
modified and stored under the original type name, but can be stored with a new name.

You can customize types in the phone jack category by modifying or entering new specifications into 
the Connector, Length, pF/ft, and Max Length (ft) fields.
See descriptions in the Data Jack Table on page 26.

Wire mapping is defined as 1-6, 2-5, and 3-4. Remaining fields and check boxes are the same or 
similar to the data jack definitions described on page 27.

When the specification of the new type is complete, a unique Type Name can be entered, and the 
new type saved in the .job file.
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2-Wire Jack Tab

The 2-Wire Jack tab controls the detailed specifications for 2 wire, single pair cables. Cables in this 
category are tested by inserting them into the F-connector or connecting them to the banana jacks on 
the Validator.  As described above, a new type can be defined by selecting an existing type from the 
drop down list  to modify, or New, to define a new type from scratch. As with Data Types, the default 
types included with Plan-Um cannot be modified and stored under the original type name, but can 
be stored with a new name.

2-Wire category cables are only tested for continuity and length. Accurate length testing relies on 
the 2 wires in the cable forming a single pair, such as coax and 2-wire twisted security cables. The 
Polarity selection box determines whether the Pass/Fail criteria for this type, is point-point (Normal), 
Reverse or Don’t Care.

The Connector field for this category is shown on the Test Results screen on the Validator and can be 
used to define a visual check for the technician at the job site to verify that the proper termination is 
on the cable.
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Bundled Cable Tab

You can create bundled cable types and give them a name, a color, and between 2 and 8 default and/
or custom cable type categories.  The user shall be able to save this bundled cable type to the job 
file and to delete this bundled cable type from the job file.  The user shall be able to select a bundled 
cable type that was previously saved and change the name, color, and the number and/or types of 
cables used in the bundle.

1.	 Select a cable from the Load Bundled Cable Types to edit or select New.

2.	 Enter a name in the line edit next to the Bundled Cable Type Name label. If you selected a 
cable to edit you must enter a new name to be able to edit the selected cable and then save.
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3.	 To Select a Bundled Cable Color, click the Change Color button. Select colors from the basic 
colors or create your own colors, then press OK.

4.	 Choose at least 2 cables of any type (except other bundled cables) as part of the bundle.  The 
eight cable check boxes to the left must be checked in sequence and unchecked in reverse 
sequence.  If the user has the first 4 check boxes checked, you can only check Cable 5 or 
uncheck Cable 4.

4.	 Click Save Type to save cable.
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Using the Zoom Feature

The default page setup is set to 100% zoom which allows the user to view the top left corner of 
the drawing canvas.  The more complex the floor plan, the more difficult it becomes to view the 
complete floor plan.  To adjust the view, click the Plus or Minus Zoom button on the icon toolbar while 
on the floor plan.  You may also click the down arrow on the Zoom dialog box and select a specific 
percentage rate for viewing the image, from 25% to 400%.  Or, to see the entire drawing page as it 
will print with the current Page Setup and Scale options, select Page.

Plan-Um remembers the last selected zoom used for the floor plan and Network View when you exit 
the program, and reopens the program with those zoom settings.

Centering the Image

The Center feature on the Icon Toolbar allows you to center the reduced or enlarged image on the 
desktop. When you click the Center icon, a dialog pop-up appears showing four buttons labeled Up, 
Left, Right, Down. Click the appropriate buttons as many times as needed to center the image on the 
desktop. When it is positioned where you want it, click the Close button.
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Showing Room Information

To improve the visibility of other details on the Floor Plan, room dimensions and room name can be 
hidden. On the Floor Plan tab, click the View drop down dialog box and select Show Dimensions to 
alternately show or hide room dimensions and room name. The free text will still appear for more 
flexible text creation.
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Cabling Between Floors (Vertical Run Feature)

You can run cabling from one floor to another with the Vertical Run feature. This allows you to have 
one main patch panel as a single point of concentration for floor plans with multiple floors. Use these 
steps to set up vertical runs.

1.	 Create multiple floors and define the ports on each floor. 

2.	 Since you are creating vertical runs between floors, identify the floor where the main 
concentrator panel for the building is located.  For example, this is often Floor 1.  On the floor 
where the main concentrator panel is located, create the cable runs from the ports to the patch 
panel.

3.	 Click the Add Vertical Run button on the Floor Tools menu.  A icon labeled Vertical Run 
appears on the floor plan. Drag and drop a vertical run icon to each floor.  A label appears 
depicting the floor number, VR for Vertical Run and 01 for the first occurrence.  
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4.	 Terminate the cable runs designated to be run between floors at the VR icon on that floor.

5.	 When complete, click the Choose Floor button and select the Floor where the cabling will 
terminate. 
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6.	 Click the Vertical Run drop down box and select the VR from which the cable originated. 

7.	 An Incomplete Cables field on the Floor Tools menu displays cables that are not yet 
terminated.  Select the cable you want to terminate from this list, then click the Finish Cable 
button and drag it from the Vertical Run icon to the concentrator panel.
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8.	 Repeat this step until all incomplete cables are terminated to the patch panel.
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Cable Test Schedule

Each cable run you define is recorded in the Cable Test Schedule, the fourth tab on the Plan-Um 
desktop. This test schedule, including results, becomes the job report that the customer receives.

Viewing the Cable Test Schedule

	 To see the complete list of defined cables, click the Cable Test Schedule tab.

Each cable in the Cable Test Schedule includes a cable ID, the port ID of the To and From 
terminations, Type, Test Jack, Use, Length, Results, Bundle Type, Bundle #, Color, and Response 
Plot. The Length and Results columns are populated after you upload the Cable Test Schedule to 
the Validator, test each cable, and download the results back to Plan-Um.

You can sort the cable list in ascending or descending order, grouping the same cable types for 
testing. To sort the cable list, click on the Type heading.
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Editing the Cable Test Schedule

Individual cells or rows on the Test Schedule can be edited using cut, copy, paste or delete.  Plan-
Um does not allow you to select and edit multiple cells at once.  A Cable Test Schedule which has 
been generated using the Floor Plan tools is linked to that floor plan, and editing entries on the Test 
Schedule screen can affect the floor plan.

The Cable ID field can be edited. A new Cable ID must not match another ID already on the Test 
Schedule.

The To and From Port ID’s can be edited on this screen, but the floor plan will not automatically 
update. If you enter a Port ID that matches one on the same floor as the original port on the floor 
plan, the cable termination will move to that port. To move a cable from one port to another, edit either 
the “From” or “To” cable values with the desired port name and select “Enter”. 

If you enter a Port ID that does not match one on the floor plan, the cable will not be visible on the 
floor plan.
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Cable Types can be changed by clicking on the drop down box, and then selecting a Cable Type in 
the list.�

The Test Jack field cannot be edited, as it is set to display the connector on the Validator, which is 
used to test cables of the Type selected in that field.�

The Use field is informational only, and can be set to any of the built-in Uses by clicking on the drop 
down box, then clicking on the desired Use. A Use is automatically assigned to a cable when a cable 
is connected between 2 Specific Use ports or 1 Specific Use and 1 General Use port on the floor 
plan. If a cable is connected between 2 different Specific Use ports or 2 General Use ports, no Use is 
assigned to that cable. �

The Length and Results fields cannot be changed by editing them on this screen. They are filled 
in during the actual cable test on the Validator. Note that changing the Type of a cable on the Test 
Schedule screen will clear the Length and Results fields, as those fields are no longer valid.�

Clicking on the Results field on the Test Schedule will switch the display to the Detailed Test Results 
for that cable.
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Each cable on the Cable Test Schedule has a color attribute which can be edited by left clicking on 
the cell showing the color.

If the cable is in a bundled cable, the type of bundled cable and the number of the cable in the bundle 
will be displayed in the Bundle Type and Bundle # columns, respectively.

The last column, Response Plot, displays whether there is any cable frequency response plot data 
available for the cable.  If data exists for the cable, the cell will show the same information as the 
Result column.  If there is no data, then the cell will display ‘No Data’. If data is available for a cable, 
clicking on the Response Plot field on the Test Schedule will pop-up a separate dialog (Frequency 
Response Plot) displaying the cable’s frequency response plot.
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Creating a Cable Test Schedule Manually

Rather than generating a cable list using the Floor Plan tools, a complete Test Schedule can 
be created using the Add Cable(s) or Define Cable(s) features to automatically assign the next 
incremental Cable ID.  

You can also manually enter Cable IDs and select a Type for each cable, or copy and paste selected 
Cable IDs on the Cable Test Schedule to create identical cable runs that can be edited.   The 
remaining fields are completely optional. 

Download this Test Schedule to Validator to perform all test functions.  You may also use this process 
to create a Cable Test Schedule directly in the Validator.

Add Cable(s) 

On the Cable Test Schedule tab, click the Add Cable(s) button to add a cable of the selected type.  
Use the drop down dialog boxes to edit the Type or Use fields.  

Define Cable(s)

On the Cable Test Schedule tab, click the Define Cable(s) button.  A dialog box pops up that allows 
the user to select the Number of Cables to Add using the default Cable ID format of Cable001, 
Cable002, etc., or to select a Custom Cable ID template and define the Cable ID sequence they wish 
to add.  Click OK and Add Cable(s) on the Cable Test Schedule and the Cable IDs you created will 
appear on the Cable Test Schedule.
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Define Custom Cable ID

To define a Custom Cable ID template, click the Custom Cable ID button on the Define Cable(s) 
dialog box.  Click Use template for Cable ID, choose numbers or letters, the beginning number or 
letter in the sequence, and the number of padding digits (Max 5).  In the template box, type the root 
Cable ID and the # sign to indicate the letter or number digits to sequentially add.  Click OK.  Click OK 
again, and then click Add Cable(s) on the Cable Test Schedule and the Cable IDs you just created 
will appear on the Cable Test Schedule.
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Viewing Detailed Cable Test Results

To view a Detailed Cable Report for each tested cable, download your test results from Validator.  
Click on Detailed Test Results and select individual cables in the pull down menu to display Pass/Fail 
Results, and all the other details of the tests run for that cable.   

Comments that may have been added in the Cable Types tab print below the test results, as well as 
the Validator serial number and software version used to test.

This information can be presented to your customer or archived for future reference. Print specific 
Test Results for each cable or select Print All to print Test Results for all cables on the Test Schedule.
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Frequency Response Plot

The cable frequency response plot data consists of three types of cable loss data measured in 
decibels in the frequency domain:  Channel Response (the signal loss associated with frequency 
dependent channel characteristics), Echo Response (the signal loss associated with reflected 
signals), and Near-End Cross Talk (the signal loss associated with noise generated by signals carried 
on other cable pairs).  The data is measured using Validator and stored in the job file for each cable 
tested.

The Frequency Response Plot depicts each cable’s channel response, echo response and near-end 
crosstalk (NEXT).  The plot is measured in decibels (dB) over the frequency domain (MHz).  The 
channel response plot is drawn in green, the echo response in blue and the NEXT in red.

The plot can be zoomed by toggling the Zoom Plot button on the dialog and then using the pointer to 
select a rectangle to zoom in on. 
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Zooming out can be achieved by right clicking on the plot.  To turn off zoom, toggle the Zoom Plot 
button.

The plot can be printed by selecting the Print button on the dialog which pops-up the 
standard print dialog.  Choose the desired printer and click on Print. The plot will also 
print during regular printing if the cable has data to print.
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Job Notes

The Job Notes section is provided so that general information regarding the job file can be recorded 
and printed.  Notes are free text and can be used to record pertinent information that may be helpful 
to the installer in the future.  Job Notes print on a separate page of the job report to avoid cluttering 
the floor plan.  

Note:  Device Notes created in the Network View section of Plan-Um print separately from text 
entered in the Job Notes section of Plan-Um. 

1.	 Click Job Notes and type the desired text on the canvas.

2.	 You can select alternate font and point sizes by clicking on the respective drop down menus on 
the formatting toolbar.  You can also apply bold or italic formatting,  underline, or right, left, or 
center justify the text  by clicking on the formatting icons on the toolbar. 
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Managing Job Files

Plan-Um uses several different types of files, each identified by a specific filename extension. 

Job Files (*.job) - The basic file type which stores Job Information, Cable Test Schedule (with test 
results), Floor Plans, and Custom Cable Types.

JDSU Template Files (*.tut) - save the Contractor Information and any Custom Cable Types defined 
in a .job file for use when creating a new job.  Use of the template (*.tut) file simplifies creation of a 
new job because you can load the template instead of reentering the information when a new job is 
created.

You can also import images as described in the section titled Defining Contractor Information.  Image 
files (.PNG, .BMP, .JPEG, .PNM, .MNG, .XBM, and .XPM) are used for adding a custom logo to 
printed job reports, and displaying a floor plan from another drawing program in the floor plan view.

The following paragraphs describe the details of using the tools available in the File menu that is 
accessed by clicking the word File in the upper left hand corner of the Plan-Um screen.

Save As Job

Use the Save As option to save a .job file on the PC under a new filename. For example, you may 
want to use the Job ID as the file name.

1.	 Click File on the menu bar and select Save as Job. This displays the standard Windows Save 
As dialog box. When Plan-Um is started for the first time the default Save In folder is My 
Documents>My Plan-Um Jobs. 

Note:  As with any software, it is always recommended to Save data occasionally.
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2.	 Plan-Um remembers the last folder used to save or open a .job file and returns to that folder 
on subsequent .job file operations. You can save the job here or in a folder of your choice.

3.	 To optionally create a new folder, click the Create New Folder icon.  A New Folder appears on 
your screen.  Type a unique name for the new folder in the box and press enter.

4.	 To complete the Save As operation, drop down to the File name field and type in a new 
filename and click the Save button.
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Save and Export as Template 

‘Export Tut File…’ is used to save the Contractor Info, Custom Cable Types, and Page settings 
defined in an open .job file for use when creating a new job.  To save this information as a template:

1.	 Select Export Tut File… on the File menu. When you select this option, the Windows Save As 
dialog box appears. 

2.	 When Plan-Um is started for the first time, the default folder used for .tut files is C:\Program 
Files\Test-Um Inc\tut if the installation was done to the default folder.  Plan-Um remembers 
the last folder used to select a .tut file for a new job and returns to that directory on subsequent 
.tut file operations. 

3.	 A new folder can be created as described above if desired.

4.	 To save your new template, type a unique name in the File name field and click Save.
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Creating a New File

1.	 Select New on the file menu to create a new file.

2.	 Type a unique filename for your new .job file in the Filename box. Select the folder where 
you want this file to be saved by clicking the Browse button.�

3.	 Navigating through the Browse For Folder dialog, or create and name a New Folder if desired. 
Click OK once you have highlighted the folder you wish to create the file in. Note that when 
Plan-Um is started for the first time, the default folder for .job files is My Documents. Plan-
Um remembers the last folder used for a .job file operation and returns to that folder on 
subsequent .job file operations.
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4.	 In the Template File field, the last template file used to create a new .job file is already 
selected. If you want to use that template, click OK to create the new file. If you want to use a 
different template, click the Browse button and select the template you wish to use for this new 
file. In either case, clicking OK will create the new file, and that file becomes the active file for 
Plan-Um to work with.

Two template files are loaded into the default tut folder during the installation process, Default.
tut and Example.tut. Using Default.tut will create a new Job with blank information. Example.tut 
can be used to preview how using a template file will work.

Archiving/Saving Test Results

After downloading a .job file containing test results from the Validator as described above, that .job 
file can be copied or saved to a special folder for backup. This is no different from copying any other 
Windows file, but is a good idea to prevent accidental overwriting of valuable data inadvertently. 

Creating a folder to store jobs that have not been tested in the field and a separate folder to store 
jobs with test results is a good practice since often jobs may be edited in the field, and may not be 
saved with a new filename. The timestamp on the file may be the only way to determine what copy of 
a file is the latest one. Updates done to a file simultaneously on the Validator and Plan-Um cannot 
be merged automatically, so if this is done, the files must be stored in separate folders so they do not 
overwrite each other. 



71

Uploading the Cable Test Schedule to the Validator

Now that the floor plans and cable runs are defined, you are ready to upload the Cable Test Schedule 
to the Validator for testing and verification.

The *.job file is a standard windows file.  When the Validator is connected to the host system via the 
USB cable it becomes a Local Disk (usually drive L:) to the PC.  Use Windows Explorer to copy and 
paste the job file to the compact flash card in your Validator or use the File Open and Save As Job 
method described here.   

1.	 Plug the USB cord into the Validator and power it on.  The USB mode screen will appear on 
Validator.

2.	 From Plan-Um, open the job you want to upload.

3.	 On the File menu, select Save As Job. When the Save As Job dialog box displays, click 
the down arrow on the Save In drop down box and select the Local Disk drive connected to 
the Validator (usually drive L:). Select Save to close the dialog box and save the file to the 
Validator.

4.	 On your Task Bar (lower right side on your desk top), click the “Unplug or Eject Hardware” 
icon.
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5.	 Click on the message to Safely Remove or Stop the USB Mass Storage Device and click again 
to Safely Remove Hardware.  The messages vary slightly depending on the version of the 
Windows Operating System on your PC.

6.	 Click OK to close the window and upload the Cable Test Schedule from Plan-Um to the 
Validator.

7.	 This completes the upload operation.  Remove the USB cable from the Validator and it will 
automatically power down.

Note: If your computer has a compact flash card reader, you can copy Jobs from 
Plan-Um to the compact flash card directly using standard windows utilities, and 
then upload the jobs to the Validator by inserting the card into the Validator.
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Downloading the Cable Test Results to Plan-Um

After you complete testing and verifying the cable job with the Validator, you will download the test 
results to Plan-Um, populating the Length and Results columns on the Cable Test Schedule.  In 
addition, the Detailed Test Results tab is populated. Use Windows Explorer to copy and paste the 
job file to the My documents>My Plan-Um Jobs folder on your PC or use the File Open and Save As 
Job method described here.   

1.	 Validator should be powered on and the current job should be saved, if Validator is not 
powered on your pc will not find the drive.

2.	 Plug the USB cord into the USB port on your PC and into the Validator.

3.	 From Plan-Um, press File Open.

4.	 When the Open dialog box displays, click the down arrow on the Look In drop down dialog box 
and select the local disk drive (usually L:) that is connected to the Validator. 

5.	 Select the job you want to download to Plan-Um and click Open.

6.	 Select the Cable Test Schedule tab or Detailed Test Results tab to view Cable Test Results.

7.	 Archive the test results to the PC. 



74

Printing the Job Report

The Floor Plan, Cable Test Schedule and Detailed Test Results can be printed to aid the installer 
performing the job or as verification of the cable installation for the customer. Your company can 
attach this End of Job report, including test results, to an invoice and present this information to your 
customer. You may also want to maintain a hard copy for your records.

To change the output of the printing select settings in the edit menu and go to the report tab of the 
settings dialog. This allows you to change the pages which will be printed. The steps to execute a 
print are as follows. 

1.	 Select Print from the File pull down menu.
 

2.	 Or use the print icon.
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Printing Floor Plans

1.	 To print a floor layout, choose the Floor Plan tab (if in current tab mode). 

2.	 To adjust print setup, page size and drawing scale options, click on page setup from the File 
drop down menu.

3.	 Select Print from the File pull down menu or use the Print icon. Unless otherwise specified, 
floor plans print on 8.5 x 11 paper in landscape mode. 

4.	 Job ID number, customer name, and the floor plan level prints in the upper left hand corner.
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Printing Cable Test Schedule

1.	 Click the Cable Test Schedule tab (if in current tab mode). 

2.	 Select Print from the File pull down menu or use the Print icon.

3.	 The Cable Test Schedule prints on 8.5” x 11” paper in portrait mode unless otherwise specified.  
If you imported your company logo, it prints in the upper right corner of the report. The Site and 
Contractor Information, plus a signature line for the installer also print. 

4.	 The Cable Test Schedule lists all identified cable runs. The Length and Result columns display 
test data downloaded from the Validator. (See the instructions for Downloading Test Results 
from Validator in this guide.)
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Printing Detailed Test Results

1.	 Click the Detailed Test Results tab (if in current tab mode). 

2.	 When you click the down arrow on the Cable field, a list of cables you have tested displays. 
Print test results for a single cable or select Print All to print the test results for each cable on a 
separate page.

3.	 Select Print from the file pull down menu or use the Print icon. 

4.	 Detailed Test Results prints on 8.5” x 11” paper in portrait mode unless otherwise specified.  If 
you imported your company logo, it prints in the upper right corner of the report. The Site and 
Contractor Information also prints.

5.	 The serial number and software version of the Validator used to test the cables prints on the 
bottom left hand corner of the document. (The serial number and software version will only be 
recorded by the Validator after a firmware update to a version later than the current 01.07.)
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Printing Cable Labels

You can also print custom laminated cable labels using Brother P-Touch printers.  Label templates 
are provided that allow you to print professional-looking flag, wrap, patch panel, or wall plate labels 
directly from the Cable Test Schedule to the following Brother P-Touch labeling systems:  PT-9600, 
PT-9500PC, and PT-18R.  Brother recommends using Flexible ID tape designed especially for 
wrapping and flagging cables, and Extra Strength Adhesive Tape for labeling patch panels and wall 
plates.

1.	 Select Print Labels from the File pull down menu or print label icon.

2.	 Using the drop down arrow, select the desired label template, wrap, patch panel, flag, or wall 
plate.  The Cable ID, To and From locations of the cable run, and Type of cable will print on the 
flag label and only the Cable ID will print on the wrap, patch panel and wall plate labels.  The 
flag and wrap labels require 1” label tape and the patch panel and wall plate labels require 
3/8” label tape.  In order to accommodate standard patch panel spacing between ports, there 
are three different patch panel templates.  Patch Panel 1 has a center-to-center length of 
0.6”, Patch Panel 2 has a center-to-center length of 1.0” and Patch Panel 3 has a center-to-
center length of 1.5”.  These different patch panel templates are useful, when combined with 
the continuous printing option, when printing the Cable ID names on one continuous label for 
application to a patch panel.
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3.	 Click the All or Select button to select the labels from the cable list to print.

4.	 If you click Select, a list box activates that allows the user to select the cables to print.

5.	 If you select All, the entire cable list will print using the selected label template.

6.	 Select ‘Continuous Printing’ if you want the labels printed on one continuous length of tape.  If 
you want each label cut separately, de-select the ‘Continuous Printing’ option.
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Emailing Job Reports 

Plan-Um job files can be emailed using one of two methods. 

If both parties have Plan-Um software installed on their computers, simply attach the .JOB files to an 
email and send the email.  �

If only the originator has Plan-Um software installed, he will need to print the job information to a 
.PDF file before emailing it. You can print job reports to PDF files using various PDF writers.  Follow 
these steps to create a PDF file:�

1.	 Start the print function in Plan-Um by clicking the printer icon on the toolbar or selecting Print 
from the File menu.

2.	 Select the PDF writer or Adobe Distiller instead of a printer in the print dialog box.�

3.	 Click the Print button to start the PDF file generation process.�

4.	 You will be prompted to save the PDF file, given the chance to select a folder in which your file 
will be stored, and enter a unique name for the file. The PDF file can be attached to an email 
and sent.

Portable Document Format (PDF) is a file format created by Adobe Acrobat to provide a standard 
form for storing, editing, and printing publishable documents on a variety of computer systems.  To 
view files of this type, download the Adobe Acrobat Reader, which is available free from Adobe’s Web 
site.  
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Context-Sensitive Help Topics
Plan-Um AP help is now available on all supported platforms including Mac OS X and Linux.  The 
help system is now context-sensitive so that when the user selects help contents, the help topic 
displayed pertains to the specific section of Plan-Um AP software being used.  To use context-
sensitive help select Contents from the Help menu or press F1 from a dialog.  This causes a program 
called Qt Assistant to run and display information for the specific topic of interest in the currently 
selected language.

Qt Assistant displays a table of contents in the Contents tab to the left, an Index tab where keyword 
searches can be performed, and Bookmarks and Search tabs.  Qt Assistant works in a similar way 
to a web browser. If you click underlined text, the documentation window will present the relevant 
page. You can bookmark pages of particular interest and you can click the Previous and Next toolbar 
buttons to navigate within the pages you’ve visited.  

Qt Assistant indexes all the pages in the documentation that it presents so that you can search for 
particular words and phrases.  To perform an index search, click the Index tab on the Sidebar (or 
click Ctrl+I). In the ‘Look For’ line edit enter a word, e.g. ‘cable’. As you type, words are found and 
highlighted in a list beneath the line edit. If the highlighted text matches what you’re looking for, 
double click it, (or press Enter) and the documentation window will display the relevant page. Note 
that for some words there may be more than one possible page that is relevant.

Qt Assistant also provides full text searching for finding specific words in the documentation. 
Documents with the highest occurrences of the word that you are looking for appear first, and every 
occurrence of the word within the documentation is highlighted.
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SOFTWARE LICENSE AGREEMENT

BY CLICKING THE “ACCEPT” BUTTON AND INSTALLING THE PRODUCT, YOU ARE CONSENTING TO BE BOUND BY 
THIS AGREEMENT.  IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, CLICK THE “DO NOT 
ACCEPT” BUTTON AND THE INSTALLATION PROCESS WILL NOT CONTINUE.  RETURN THE PRODUCT TO THE 
PLACE OF PURCHASE FOR A FULL REFUND, OR DO NOT INSTALL THE PRODUCT.

End User shall obtain all JDSU (LICENSOR) product materials through JDSU or it’s authorized Distributors and no other 
source.  JDSU authorized product materials include, but are not limited to, manuals, license agreements, and media upon 
which company’s proprietary computer programs are recorded.  End User shall make no copies of the materials furnished 
by JDSU, unless specifically authorized to do so in writing signed by an officer of JDSU

End User agrees that JDSU retains exclusive ownership of the trademarks represented by its company name and product 
name, and all of the documentation and computer recorded data related thereto. End User also agrees that all techniques, 
algorithms, and processes contained in LICENSOR’S computer program products constitute TRADE SECRETS OF JDSU  
End User shall not copy, reproduce, remanufacture, or in any way duplicate or modify all or any part of LICENSOR’S 
products WHETHER TRANSLATED INTO ANOTHER LANGUAGE OR NOT.

IN NO EVENT WILL JDSU OR ITS SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT, OR DATA, OR 
FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR PUNITIVE DAMAGES HOWEVER CAUSED AND 
REGARDLESS OF THE THEORY OF LIABILITY ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE 
EVEN IF JDSU OR ITS DISTIBUTORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  IN NO 
EVENT SHALL JDSU OR ITS DISTRIBUTORS LIABILITY TO THE END USER, EXCEED THE PRICE PAID BY THE 
CUSTOMER.
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Regional Sales

North America
Tel: +1 805 383 1500
Fax:+1 805 383 1595

Latin America
Tel: +55 11 5503 3800
Fax:+55 11 5505 1598

Asia Pacific
Tel: +852 2892 0990
Fax:+852 2892 0770

EMEA
Tel: +49 7121 86 2222
Fax:+49 7121 86 1222
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